C-Bus Manual Addendum v2.1.1
C-Bus Calculator

Version:
211B
Table of Contents

Chapter 1  Introducing C-Bus Calculator ................................................................. B-1
  Introduction ........................................................................................................ B-1

Chapter 2  C-Bus Network Design Philosophy ....................................................... B-2
  Design Approach ................................................................................................ B-2
  Design Checklist .................................................................................................. B-3

Chapter 3  Software Installation Procedures .......................................................... B-4

Chapter 4  Software Overview ............................................................................... B-5
  Using C-Bus Calculator ......................................................................................... B-5
  C-Bus Project Details .......................................................................................... B-6
  Network Design ................................................................................................... B-7
  Calculator Results ............................................................................................... B-9
  Help ....................................................................................................................... B-12
  Future Upgrades ................................................................................................. B-12
  Export Customers ............................................................................................... B-12
  Notes : .................................................................................................................. B-13

List of Figures ....................................................................................................... B-14
Chapter 1  Introducing C-Bus Calculator

Introduction

The C-Bus Calculator is a Software Tool which allows for the verification of a C-Bus Network Design to ensure reliable operation without the guess-work. C-Bus Calculator examines critical operating parameters of the proposed Network, and indicates whether or not that design is valid. Where a Network design is deficient, the user is prompted to correct the fault.

C-Bus Network operating parameters examined by C-Bus Calculator include:

- Maximum number of Units on a Network
- Combinations of Unit Types allowed on a C-Bus Network
- Total Current Consumption
- Power Supply Requirements
- Safety issues with respect to maximum supply current (in case of a short circuit on the C-Bus)
- Network AC Impedance
- Network Burden Status
- C-Bus System Clock Status

This Manual Addendum has been written as a supplement to the existing C-Bus Installation Software Manual (Clipsal Catalog Number 5000S/2, 5000M/2). The C-Bus Calculator is introduced, and working examples of its usage presented.

It is assumed that the user is familiar with the basic concepts of using C-Bus. If not, it is recommended that the user take the time to read the C-Bus Installation Software Manual.

It is strongly recommended that the C-Bus Calculator software utility now be used for verification of EVERY Network Design that you undertake.
Chapter 2  C-Bus Network Design Philosophy

Design Approach

There are several methods of designing and installing C-Bus. For a full description, please refer to the C-Bus Manual, Part B. An overview of the recommended approach is shown below.

![C-Bus Installation Approach Diagram]

Figure 2.1  C-Bus Installation Approach
Design Checklist

During the planning stages, and after installation has been completed, take the time to run through the following checklist of design requirements …

Have you:

- Verified your C-Bus Network Design using C-Bus Calculator?
- Used C-Bus Category 5 UTP Cable?
- Observed recommended low voltage cable colour coding scheme (or otherwise used an appropriate twisted pair cabling arrangement)?
- Provided Overvoltage protection for the Electronic Equipment?
- Provided adequate segregation between mains and C-Bus Network cabling (50mm minimum, 100mm recommended)?
- Provided good quality and reliable terminations?
- Allowed for an adequate number of Power Supplies (as recommended by the C-Bus Calculator)?
- Distributed Power Supplies evenly throughout the Network?
- Allowed for System Clock on each Network (as recommended by the C-Bus Calculator)?
- Optimised the usage of a Network Burden on each Network (as recommended by the C-Bus Calculator)?
- Provided less than 100 Units per Network?
- Provided less than 255 Networks?
- Provided less than 1000 metres total cable length on any one Network?
- No closed loop ring wired structures?
- Minimised the depth of the Network Topology?
- Given careful consideration to appropriate Unit placement (with respect to temperature, mains cabling, sources of electrical noise and other interference)?
- Considered providing built-in redundancies such as additional Power Supplies to accommodate future expansions.

For more information, please refer to the C-Bus Installation Manual, Part B.
Chapter 3  Software Installation Procedures

NOTE:

1. The C-Bus Calculator is a 32 Bit software application, and as such will not run under Windows 3.11. Only Windows 95/98/2000 and Windows NT platforms are supported.

2. It is highly recommended that you quit from all other programs before proceeding with the installation process.

Windows 95 Setup Instructions

The C-Bus Installation Software runs under Microsoft Windows 95 or later. It is assumed that the user is familiar with this environment.

1. Insert Disk 1 – Setup into drive A.
2. Click the Start Menu, and select Run...
3. Type a:\setup and press the ENTER key.

Once installed the C-Bus Calculator Software can be launched by double-clicking on the program icon.

The C-Bus Calculator can be installed as a stand-alone application, and does not require C-Bus Installation Software v2.x.x to be installed as a pre-requisite. If the C-Bus Software is installed, then the Calculator may be accessed under the File Menu, as shown below.

Figure 3.1  Accessing C-Bus Calculator from C-Bus Installation Software v2.x.x
Chapter 4  Software Overview

Using C-Bus Calculator

To use C-Bus Calculator, simply follow the steps shown in the following flow diagram.

Figure 4.1  C-Bus Calculator Network Verification Procedure
C-Bus Project Details

The C-Bus Calculator Software allows detailed data to be recorded about the project, including the name and contact details of the installer, and the name and location of the Project Site.

The details entered here are primarily for record keeping and project tracking purposes. Access the dialog by choosing Edit Project Details from the File Menu, or double-clicking the Project Detail Summary at the top of the main screen.

It is recommended that the Project Details be filled in and saved, allowing the installer to keep track of individual projects. The Notes section can be used to record any special circumstances or problems concerning the project.

Figure 4.2  C-Bus Calculator – Project Details
Network Design

C-Bus project design details are entered from the main screen (shown below). The C-Bus Calculator contains a fully upgradable database of available C-Bus devices. Each device has been characterised with respect to AC Impedance, Power Supply requirements, and various other operating parameters.

There are several tabs on the main screen. The default tab (All Units) shows a list of all available units modelled in the database of Unit Types. Each subsequent tab shows a cut down list, sorted by function. The final tab shows only those Unit Types included in the current network design (Selected Units).

Network Design verification using C-Bus Calculator is a simple matter of building the Network (by specifying the number of each device type) in the table presented.

The C-Bus Calculator can handle multiple Network C-Bus installations. Specify the number of Networks required on the Project Details screen. Click the Network X of Y selection arrows at the top of the main screen to select the required Network.
To add units to the Network Design, select and highlight the unit type of interest (e.g. 1 Gang Key Input), and either:

- Left Click in the Quantity (QTY) column to increase the number of units
- Right Click in the Quantity (QTY) column to decrease the number of units
- Move the slider (shown on far right of main screen) until the correct number of units are shown
- Type in the Unit quantity required using numeric keys on the keyboard

Repeat the above procedure until all required devices have been added to the Network (per design). The C-Bus Calculator Results (shown at the top of the main screen) are then used to determine if the Network Design is valid. If the Calculator indicates a problem (red or yellow bar graph), then steps should be taken to correct the design flaw.

Helpful hints are offered to assist the designer, including:

- **Unit Parameters.** Double-click on any Unit in the main screen to display some basic properties for that type of device;
- **Fault Report.** Where C-Bus Calculator determines that there is a flaw in the Network design, you can double click in the Results area for further information.
- **Help.** Access Help information from the Help Menu, or press F1 at any time you need more information.
Calculator Results

Once all design information has been entered, the C-Bus Calculator displays it’s results at the top of the main screen.

The goal is to balance the number of units in a C-Bus Network so that no red bars appear on the screen. If a red bar appears, just click it for an action prompt, or double-click for a C-Bus hint.

An example of a valid Network design is shown below.

![Figure 4.5 C-Bus Calculator Results](image)

**Figure 4.5 C-Bus Calculator Results**

![Figure 4.6 C-Bus Calculator – Example of a valid Network Design](image)

**Figure 4.6 C-Bus Calculator – Example of a valid Network Design**
The C-Bus Calculator is used to ensure a valid Network has been designed. This entails verification that:

- There is a Clock Unit on the Network;
- There is adequate Power Supply for the Units selected;
- The AC Impedance presented by the Units selected is acceptable.

There are three possible results:

<table>
<thead>
<tr>
<th>Result</th>
<th>Description</th>
<th>Colour Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOOD (OK/SAFE)</td>
<td>Network design is valid. Proceed with installation.</td>
<td>Green</td>
</tr>
<tr>
<td>MARGINAL</td>
<td>Network design is barely adequate. Network will not survive a single Unit / Installation fault. Changes are suggested for a more robust installation.</td>
<td>Yellow</td>
</tr>
<tr>
<td>BAD (UNBALANCED / ADD X)</td>
<td>Network design is flawed. Corrective action is required before proceeding.</td>
<td>Red</td>
</tr>
</tbody>
</table>

If the Calculator indicates Bad or Marginal results, then the suggested changes should be considered in order for the Network design to be ratified.

The following examples show invalid Network designs that require modification if the installation is to be successful.

Figure 4.7 C-Bus Calculator - Example of an Invalid Network Design
The first example shows a Network that does not have enough power to supply the selected Units. The user is prompted to add more Power Supply Units to the Network design.

The second example shows a Network that has too many Power Supply Units. The user is warned that the total current supplied is greater than two amps. This exceeds the maximum ratings of a Category 5 cable conductor pair as used in the C-Bus cabling convention. If a short circuit condition were ever to occur, there would be a risk of fire. In this instance a dialog box appears recommending that the Network be sub-divided to form two separate Networks. If this is not desirable, then simply reducing the number of Power Supplies may avoid the problem.
Help

The C-Bus Calculator software features tool tips, pop-up hints, and an extensive online Help facility.

The Help System is accessible by pressing F1 at any time, or by selecting Contents from the Help Menu.

![C-Bus Calculator Help System]

Future Upgrades

The modular design of the software allows upgrades to be performed, simply by replacing the shipped data file (CBUSUNIT.DAT). As new products are released, they will be characterised, and the data file updated to include the new Unit Type.

Updates will be posted on the web, at the following URL:

http://www.clipsal.com

Follow the links to the Clipsal Integrated Systems site.

Export Customers

The data file shipped with C-Bus Calculator contains a database of C-Bus products available. Each has been characterised for calculating network impedances etc. Units specified are listed by Description and Catalog Number. Only the Australian Catalog Number is listed. Export customers may substitute the generic Australian equivalent product in place of the export series catalog item.

For example: Substitute 5031N for E5031N, S5031N
Notes:

The C-Bus Calculator is an aid to design only. The calculations made are theoretical, and do not account for all installation variables. Practical wiring considerations such as cable capacitance, termination impedances and other factors may influence network performance.

All previously published C-Bus wiring rules and recommendations still apply.

The information published herein is subject to change without notice.
List of Figures

FIGURE 2.1 C-BUS INSTALLATION APPROACH .................................................................B-2
FIGURE 3.1 ACCESSING C-BUS CALCULATOR FROM C-BUS INSTALLATION SOFTWARE v2.X.X .......B-4
FIGURE 4.1 C-BUS CALCULATOR NETWORK VERIFICATION PROCEDURE .......................................B-5
FIGURE 4.2 C-BUS CALCULATOR – PROJECT DETAILS ..............................................................................B-6
FIGURE 4.3 C-BUS CALCULATOR – NETWORK DESIGN ..............................................................................B-7
FIGURE 4.4 C-BUS CALCULATOR – HELPFUL HINTS ..............................................................................B-8
FIGURE 4.5 C-BUS CALCULATOR RESULTS ...............................................................................................B-9
FIGURE 4.6 C-BUS CALCULATOR – EXAMPLE OF A VALID NETWORK DESIGN ........................................B-9
FIGURE 4.7 C-BUS CALCULATOR - EXAMPLE OF AN INVALID NETWORK DESIGN .................................B-10
FIGURE 4.8 C-BUS CALCULATOR - EXAMPLE OF AN UNSAFE NETWORK DESIGN .................................B-11
FIGURE 4.9 C-BUS CALCULATOR HELP SYSTEM ....................................................................................B-12